
  
 

   
 

  

  

  
  
  
  
  
  
 
 

  
 
 
 
 
 

Wimba Pronto Basic 
  

Version 2.1 
  

User Guide 



  
 

Wimba Pronto Basic 2.1 User Guide 
Welcome to Wimba Pronto Basic _______________________________________________________________ 1 

What's New in Wimba Pronto Basic? ___________________________________________________________ 2 

Differences Between Wimba Pronto and Wimba Pronto Basic _______________________________________ 2 

Getting Started _____________________________________________________________________________ 3 

Wimba Pronto Basic System Requirements ______________________________________________________ 3 

Creating a New Wimba Pronto Account ________________________________________________________ 4 

Linking Accounts ___________________________________________________________________________ 6 

Downloading and Installing Wimba Pronto Basic _________________________________________________ 7 

Logging In ________________________________________________________________________________ 9 

Interface Overview _________________________________________________________________________ 10 

About the Wimba Pronto Basic Interface _______________________________________________________ 10 

The Contacts Tab __________________________________________________________________________ 11 

The Classmates Tab ________________________________________________________________________ 12 

The Status Bar ____________________________________________________________________________ 13 

The Menu Bar _____________________________________________________________________________ 13 

Managing Your Accounts and Contacts ________________________________________________________ 14 

About Wimba Pronto Accounts and Contacts ___________________________________________________ 14 

Adding a New Contact to Your Contacts Tab ___________________________________________________ 15 

Adding a New Group to Your Contacts Tab _____________________________________________________ 16 

Adding a Contact to a Group ________________________________________________________________ 17 

Removing a User From Your Contacts Tab or a Group ____________________________________________ 18 

Changing Your Status ______________________________________________________________________ 19 

Creating a New Custom Status _______________________________________________________________ 20 

   
 



  
 

Modifying Your Profile _____________________________________________________________________ 21 

Changing Your Display Settings ______________________________________________________________ 23 

Blocking and Unblocking Users ______________________________________________________________ 25 

Viewing a User's Profile _____________________________________________________________________ 27 

Accessing the Wimba Pronto Settings Page ____________________________________________________ 28 

Modifying Your Account Settings _____________________________________________________________ 29 

Modifying Your Course Settings ______________________________________________________________ 31 

Text Chat __________________________________________________________________________________ 32 

About Text Chat ___________________________________________________________________________ 32 

The Text Chat Window _____________________________________________________________________ 33 

Starting a New Text Chat ____________________________________________________________________ 35 

Emoticons _______________________________________________________________________________ 36 

Audio Calling ______________________________________________________________________________ 37 

About Audio Calling _______________________________________________________________________ 37 

The Audio Call Window _____________________________________________________________________ 38 

Starting a New Audio Call ___________________________________________________________________ 40 

Group Chat ________________________________________________________________________________ 41 

About Group Chat _________________________________________________________________________ 41 

The Group Chat Window ____________________________________________________________________ 42 

Starting a New Group Chat __________________________________________________________________ 44 

Inviting New Users to a Current Group Chat ____________________________________________________ 46 

Preferences ________________________________________________________________________________ 47 

Accessing the Preferences Window ___________________________________________________________ 47 

General Preferences _______________________________________________________________________ 48 

Appearance Preferences ____________________________________________________________________ 50 

   
 



  
 

   
 

Status Preferences _________________________________________________________________________ 52 

Alerts Preferences _________________________________________________________________________ 53 

Calls Preferences __________________________________________________________________________ 54 

Privacy Preferences ________________________________________________________________________ 55 

Profile Preferences _________________________________________________________________________ 56 

Message Logs ______________________________________________________________________________ 58 

Saving a Single Chat _______________________________________________________________________ 58 

Enabling Automatic Message Log Saving ______________________________________________________ 59 

Viewing Message Logs _____________________________________________________________________ 60 

Language Settings _________________________________________________________________________ 61 

Keyboard Shortcuts ________________________________________________________________________ 62 

Software Updates _________________________________________________________________________ 63 

Additional Resources _______________________________________________________________________ 64 

Product Feedback _________________________________________________________________________ 65 

Disclaimer _________________________________________________________________________________ 66 

 



  
 

Welcome to Wimba Pronto Basic 

 
  

Wimba Pronto Basic is an academic-centric instant messaging platform designed to bring informal learning settings 

online. One of the main differences between Wimba Pronto Basic and other instant messaging programs is that 

Wimba Pronto Basic is synchronized with your institution's Course Management System (CMS). This means that 

students and teachers are automatically connected with other Wimba Pronto users enrolled in the same courses. 

Wimba Pronto Basic also  includes advanced features that allow everyone at your institution to collaborate and 

communicate quickly and easily.  

  

This guide will take you through all of the features of Wimba Pronto Basic. Whether this is your first time using 

instant messaging, or you're an advanced user, you'll find new ways to collaborate and communicate with Wimba 

Pronto Basic. 
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What's New in Wimba Pronto Basic? 

 If you've used Wimba Pronto in the past, but are curious about what's new, the list below includes the most recent 

changes so that you can get up and running quickly with all of the latest features. 

Wimba Pronto Basic 2.1 

  

• Spanish Language Support: Wimba Pronto is now available in both English and Spanish. 

• Improved Accessibility: new keyboard commands and screen reader support (JAWS for Windows and 

Voice Over for Mac)  

  

See Also: 

Language Settings 

 

Differences Between Wimba Pronto and Wimba Pronto Basic 

You are currently using Wimba Pronto Basic, a free version of Wimba's more advanced product, Wimba Pronto. The 

full version of Wimba Pronto contains many new features and enhancements that can help you and your institution 

communicate, work, and collaborate more easily and more effectively.  

Advanced Features in Wimba Pronto Include: 

  

• Application Sharing for real-time display of any document or application on your computer 

• Video Calling with blended audio and video for face-to-face contact and more natural communication 

• Queued Chat for holding office hours and managing individual attention with a large number of users 

• Help Desks for making all of your institution's services available online 

• Broadcast Notifications for sending institution-wide broadcast messages to every Wimba Pronto user on 

campus 

  

For more information on Wimba Pronto, or to upgrade, contact Wimba. 
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Getting Started 

Wimba Pronto Basic System Requirements 

The minimum system requirements for Wimba Pronto Basic are as follows:  

• Windows 2000+ or Mac OS 10.4+  

• 128 MB RAM (256 MB recommended)  

•  An Internet connection at 56 kbps or higher  

•  Sound Card (for Audio Calling)  

•  Speakers and Microphone for Audio Calling (USB headset with integrated microphone recommended).  
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Creating a New Wimba Pronto Account 

Since Wimba Pronto Basic is linked with your institution's Course Management System (CMS), you must access the 

Wimba Pronto Sign Up page via a Pronto link in your CMS. The first step of the account creation processes varies 

slightly between Course Management Systems. 

To Create a New Wimba Pronto Account 

1. Log in to your Course Management System. 

2. Click any Wimba Pronto link. The Wimba Pronto Sign Up page opens. 

 

 

• If you are using Blackboard Learning Systems Enterprise, the Pronto link may be located in the 

Communication Area, the Tools Area, or on the My Institution page. 
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• If you are using Blackboard Learning Systems (WebCT) or Vista 4/CE, the Pronto link may be located in 

the External Courses area of the My Blackboard (or My WebCT) page, or within a Section. 

 

 
 

• If you are using Moodle, the Wimba Pronto link can either be an activity within a course, or an image 

within a Block. 

 

 
 

3. Complete the account registration form.  

4. Click the Submit button. A confirmation email is sent to the address that you provided. 

5. Check your email. 

6. Click the confirmation link in the email. Your account is activated. 

  

Note: 

Unlike in other instant messaging programs, in Wimba Pronto Basic, you are identified by your full name, as it 

appears in your institution's Course Management System. There is also a Pronto ID associated with your account, 

which is used for logging in, managing your account, and allowing users who are not in your classes to contact 

you. 

See Also: 

Downloading and Installing Wimba Pronto 
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Linking Accounts 

If you change institutions and want to continue using your existing Wimba Pronto account, you can link it to your 

new institution's CMS server. As long as you are still active on your previous institution's server, you can also access 

a list of your classmates for both institutions simultaneously.  

To Link an Existing Wimba Pronto Account to a New CMS Server 

1. Log in to your new institution's CMS server. 

2. Click any Wimba Pronto link. The Wimba Pronto Sign Up page opens. 

 

 

 

3. Click the I already have a Wimba Pronto account link. The Link Your Wimba Pronto Account page opens. 

4. Log in using your existing Wimba Pronto account information. Your new CMS account is linked to your 

Wimba Pronto account and the Wimba Pronto Settings page opens. 
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Downloading and Installing Wimba Pronto Basic 

After creating your Wimba Pronto account, you can download and install the Wimba Pronto Basic client. You can 

perform this step either immediately after activating your account, or at a later time. 

Downloading and Installing Wimba Pronto Basic for Windows 

1. Log in to the Wimba Pronto Settings page using your Pronto ID and password. 

 

• If you just activated your account, you may already be logged in to the Wimba Pronto Settings page. 

• If you did not just activate your account, or you need to download and install Wimba Pronto Basic 

again, go to http://pronto.wimba.com and sign in using your Pronto ID and password. 

2. Click the Download Wimba Pronto for Windows graphic. The Wimba Pronto Basic installer is downloaded 

to your hard drive. 

3. Double-click the ProntoSetup icon on your desktop. The Pronto Setup launches. 

4. Select a default language for the Wimba Pronto Basic client. 

5. Click OK. 

6. Click Next >. 

7. Review the license agreement and click I Agree. 

8. Select whether you wish to install Desktop and QuickLaunch Shortcuts. 

9. Click Next >. 

10. Select where you wish to install Wimba Pronto Basic. 

11. Click Install. Wimba Pronto Basic is installed and a confirmation screen opens. 

12. Select whether you wish to run the program right away. 

13. Click Finish. 

  

Note: 

Regardless of which language you select during installation, Wimba Pronto Basic is installed in both English and 

Spanish. You can change your language setting at any time from the Preferences window.  

Downloading and Installing Wimba Pronto Basic for Mac 

1. Log in to the Wimba Pronto Settings page using your Pronto ID and password. 

 

 

• If you just activated your account, you may already be logged in to the Wimba Pronto Settings page, or 

you may already be at the Wimba Pronto Settings login page. 

• If you did not just activate your account, or you need to download and install Wimba Pronto Basic 

again, go to http://pronto.wimba.com and sign in using your Pronto ID and password. 

2. Click the Download Wimba Pronto for Mac OS X graphic. The Wimba Pronto Basic installer is downloaded 

to your hard drive and the Pronto EULA opens. 

3. Review the license agreement and click Agree. The Pronto disk image opens.  

4. Drag the Pronto icon to your Applications folder. 
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Tip: 

You can install Wimba Pronto Basic on as many computers as you wish, making it easy to keep in touch with 

friends and classmates, even if you are not at your primary computer. 

  

See Also: 

Language Settings 

Creating a New Wimba Pronto Account 

Accessing the Wimba Pronto Settings Page 
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Logging In 

You log in to the Wimba Pronto Basic client using the Pronto ID and password that you chose when creating your 

account. Whenever you launch Wimba Pronto Basic, the login window appears. 

To Log in to Wimba Pronto Basic 
 

 
 

1. Enter your Pronto ID. 

2. Enter your password. 

3. Click the sign in button.  

  

Tips: 

a) You can set Wimba Pronto Basic to remember your Pronto ID and password by checking the remember me 

box. If you do this, anyone with access to your computer can access your Wimba Pronto account.  

b) You can also set Wimba Pronto Basic to automatically sign you in when you launch the program by checking 

the sign in automatically box. This setting can be changed in the Preferences window. 

  

See Also: 

Creating a New Wimba Pronto Account 
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Interface Overview 

About the Wimba Pronto Basic Interface 

Wimba Pronto Basic is based around the Wimba Pronto window, from which you manage communication with 

other users and access the program's more advanced features. The four main elements of the Wimba Pronto 

window are: the Contacts tab, the Classmates tab, the Status Bar, and the Menu Bar. 

  

 
Note: The School tab is an advanced feature in Wimba Pronto and is not available in Wimba Pronto Basic. 

  

Note: 

On Mac OS version, the Menu Bar is located at the top of the screen, rather than within the Wimba Pronto 

window. 

See Also: 

Adding a New Contact to Your Contacts Tab 

Changing Your Status 
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The Contacts Tab 

 
Note: The School tab is an advanced feature in Wimba Pronto and is not available in Wimba Pronto Basic. 

  

The Contacts tab is where you keep track of your friends, study groups, and anyone else that you contact often. This 

tab is initially empty, but you can add any Wimba Pronto user, as long as you know his or her Pronto ID; the user 

does not need to be in one of your classes, or even at your institution. The Find field allows you to search for a 

specific user in the list. You can also add groups to keep your contacts organized. 
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The Classmates Tab 

 
Note: The School tab is an advanced feature in Wimba Pronto and is not available in Wimba Pronto Basic. 

  

The Classmates tab lists all of the Wimba Pronto users who are in your classes. If the instructor of a course has a 

Wimba Pronto account, the label (Instructor) appears next to his or her name. You do not need to add users to 

your Classmates tab; it is automatically populated based on course enrollments within your institution's Course 

Management System (CMS). You also cannot manually add or delete users. The Find field allows you to search for 

users in the list. 

  

Tip: 

Classmates appear in your Classmates tab only while you are enrolled in a class. However, users remain in your 

Contacts tab indefinitely, so make sure you add classmates with whom you want to keep in touch as contacts 

before the semester ends. 
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The Status Bar 

 
  

The Status Bar shows your current availability. Since other Wimba Pronto users see this status, you can use it to tell 

other people what you are doing and if it is a good time to contact you. Status messages are fully customizable and 

can be saved for future use. 

 

The Menu Bar 

 
  

The Menu Bar provides access to nearly every feature in Wimba Pronto Basic. While many of the commands can be 

accessed from other places in the program, the Menu Bar provides quick, convenient access to commonly used 

features. The Menu Bar is also where you can access the Preferences window, modify display options, and exit the 

program. 
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Managing Your Accounts and Contacts 

About Wimba Pronto Accounts and Contacts 

One of the unique features of Wimba Pronto Basic is that it automatically populates your Classmates tab, allowing 

you to communicate with other Wimba Pronto users in your classes without having to know their Pronto IDs. You 

can quickly see how many people from each of your classes use Wimba Pronto Basic, and who is currently online. 

You can still keep a personalized list of users by using the Contacts tab, which allows you to add Wimba Pronto 

users, regardless of whether or not they are in your classes.  
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Adding a New Contact to Your Contacts Tab 

The Contacts tab is where you keep track of your friends, classmates, instructors, and anyone else that you want to 

be able to easily contact. You can add any Wimba Pronto user to your contacts, even if they are not in one of your 

classes or enrolled at your institution. 

  

To add a classmate to your Contacts tab, click the plus icon  next to the user's name in the Classmates tab. The 

smiley icon  indicates that the user has been added to your Contacts tab. 

  

 
Note: The School tab is an advanced feature in Wimba Pronto and is not available in Wimba Pronto Basic. 

To Add a User to Your Contacts Tab by Pronto ID 

1. Click the Actions menu. 

2. Select Add Contact... The Add Contact window opens. 

3. Type the Pronto ID of the user you wish to add. 

4. Select the group within your Contacts tab to which you wish to add the person. 

5. Click Add. The user is added to your Contacts tab. 

  

Note: 

You can use the Pronto ID method to add any Wimba Pronto user to your Contacts tab, even if they are in your 

Classmates tab. However, clicking the plus icon is the faster way to add classmates. 

Tip: 

If a user that is not in your Contacts or Classmates tab contacts you, a notification appears above the message 

giving you the option to add the user to your Contacts tab or, alternately, to block the user.  

  

See Also: 

Adding a New Group to Your Contacts Tab 

Adding a Contact To a Group 

Removing a User From Your Contacts Tab or From a Group 
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Adding a New Group to Your Contacts Tab 

You can organize users in your Contacts tab by groups. For example, you could create a group for your study 

partners, or for your friends from high school. When you start Wimba Pronto Basic for the first time, the Contacts 

tab is empty. When you add a new contact, unless you specify otherwise in the Add Contact window, the user is 

automatically added to a default group called Recently Added. You can create as many groups as you wish to keep 

your contacts organized. 

To Create a New Group 

1. Click the Actions menu. 

2. Select Add Group... The Add Group window opens. 

3. Type the name of the group you wish to create. 

4. Click Add. The group is created and added to your Contacts tab. 

  

See Also: 

Adding a New Contact to Your Contacts Tab 

Adding a Contact To a Group 
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Adding a Contact to a Group 

Once you have created groups in your Contacts tab, the next step is to add contacts to these groups. There are a 

couple of different ways to add a contact to a group, depending on whether or not you have already added the 

user to your Contacts tab. 

  

To add a user that is already in your Contacts tab to a group, simply drag and drop his or her name to the name of 

the group. 

 

 
Note: The School tab is an advanced feature in Wimba Pronto and is not available in Wimba Pronto Basic. 

To Add a User Not Already in Your Contacts Tab to a Group 

1. Click the Actions menu. 

2. Select Add Contact. The Add Contact window opens. 

 

 
 

3. Type the Pronto ID of the person you wish to add. 

4. Select the group to which you wish to add the person. 

5. Click Add. The user is added to the selected group within your Contacts tab. 

  

See Also: 

Adding a New Contact to Your Contacts Tab 

Adding a New Group to Your Contacts Tab 

Removing a User From Your Contacts Tab or From a Group 
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Removing a User From Your Contacts Tab or a Group 

The process for removing a user from your Contacts tab is the same as removing a user from a group; if you remove 

a user from a group, he or she is also removed from the Contacts tab (unless the person is in more than one group). 

There two different ways to accomplish this. 

To Remove a Contact Using the Contacts Tab 

1. Click the Contacts tab, if it is not already selected. 

2. Right-click (Ctrl-click on Mac) the name of the contact that you wish to remove. 

3. Select Remove <User Name>. The Remove <User Name> window opens. 

4. Click OK. The user is removed from both the Contacts tab and the group. 

To Remove a Contact Using the Actions Menu 

1. Click the Contacts tab, if it is not already selected. 

2. Click the name of the contact that you wish to remove. 

3. Click the Actions Menu. 

4. Select Remove <User Name>. The Remove <User Name> window opens. 

5. Click OK. The user is removed from both the Contacts tab and the group. 

  

Note: 

If you remove a contact that is in one of your courses, he or she will still be listed in your Classmates tab. Since the 

Classmates tab is automatically populated from your institution's CMS, you cannot manually add or remove 

classmates. 

See Also: 

Adding a New Contact to Your Contacts Tab 

Adding a Contact To a Group 
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Changing Your Status 

The Status Bar displays your current availability. Other Wimba Pronto users see this status, so you can use it to tell 

other people what you are doing, and if it is a good time to contact you. You can change your status to one of the 

default options, or create a new custom status.  

  

The default status options are:  

• Available  

The Available status lets other users know that you are free and that it's a good time to contact you. 

• Away  

The Away status lets other users know that you are busy and that it may not be a good time to contact you. 

You may wish to create a custom away status to let other people know what you're doing or when you'll be 

back. 

• Invisible  

The Invisible status is a way of hiding yourself from other users while still remaining online. When you set 

your status to invisible, you appear to others users as if you were offline, but you can still communicate with 

other users normally. If your status is set to Invisible and another user tries to send you message, you will 

receive the message. 

• Offline   

The Offline status is the same as logging out of your Wimba Pronto Account; when you are offline, you 

cannot contact other users and other users cannot contact you. If you are offline, and another user tries to 

send you a message, you will not receive the message. 

To Change Your Status  

1. Click the Status Bar. 

 

 
Note: Queuing is an advanced feature in Wimba Pronto and is not available in Wimba Pronto Basic. 

 

2. Select the desired status. Your new status is set. 

 

See Also: 

Creating a New Custom Status 
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Creating a New Custom Status 

If you do not want to use the default status messages, or you prefer to display a more specific message, you can 

create a custom status. While the most common use of custom statuses is creating custom away messages, you can 

also create a custom available status. Custom statuses can be saved for future use.  

To Create a New Custom Status 

1. Click the Status Bar. 

2. Select Custom... under either Available or Away. The Edit Custom Status window opens. 

 

 
 

3. Type a name for the status in the Title field. This title is for your own reference only and is not seen by other 

users. 

4. Type the status in the Message field. This is the text that is displayed to other users. 

5. If you wish to be able to reuse this status in the future, check the Save for future use box. 

6. If you want other users to automatically receive a reply message with your status when enabled, check the 

Auto-reply box. 

7. Click OK. The custom status is created and is set as your current status. 

  

Tip:  

If you want the Title and the Message of the Status to be the same, you can simply type the text in the Message 

field; the Title field is filled in automatically. 

  

See Also: 

Changing Your Status 
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Modifying Your Profile 

You can create a personalized profile with a picture to share information about yourself with other Wimba Pronto 

users. Adding a picture, or other information, is optional. You can add or modify profile information from the Profile 

section of the Preferences window.  

  

To access the Profile editor, click your profile picture box to the left of the Status Bar in the Wimba Pronto window. 

  

 

Profile Picture 

You can add a profile picture that is visible to other Wimba Pronto users to add a personal touch to your profile. 

Your picture is visible any time you contact another Wimba Pronto user, anytime another user contacts you, when a 

user views your profile, or when a user hovers his or her cursor over your name in the Contacts or Classmates tab. 

To add a profile picture, either drag an image file from your hard drive to the Drag Image Here box, or click the 

Choose Picture... button and browse your hard drive for the desired picture. The profile picture box is optimized 

for square images, but accepts images of any proportions.  

Email 

You can add an email address to make it easier for other users to contact you when you're not on signed in to 

Wimba Pronto Basic. This address does not need to be your school email address or the address associated with 

your Wimba Pronto account. 
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About Me 

The About Me box allows you to type a brief description to introduce yourself to other users. You may wish to 

include your interests, your major, where you're from, or the type of people with whom you would like to 

communicate using Wimba Pronto Basic.  

My Webpages 

The My Webpages box allows you to include links in your profile to the websites of your choice. You may wish to 

add personal, course, or department webpages. 

  

See Also: 

Profile Preferences 
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Changing Your Display Settings 

Using the View menu, you can control the way in which users are displayed in the Wimba Pronto window. These 

display settings apply to both the Contacts and the Classmates tabs.  

  

 

Show Offline Contacts 

Toggles the display of users that are not currently logged in to Wimba Pronto Basic 

Show Blocked Contacts 

Toggles the display of users that you have blocked 

Sort Contacts by First Name 

Displays users organized alphabetically by first name 

Sort Contacts by Last Name 

Displays users organized alphabetically by last name 
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Sort Contacts by Availability 

Displays users that are available first, followed by users that are away, users that are idle, and users that are offline 

Show Group Counts 

Toggles the display of user counts for each group or course 

Collapse All Groups 

Hides the user list for all groups, showing only the group name. You can collapse or expand individual groups by 

clicking the arrow next to the group name. 

Expand All Groups 

Reveals the user list for all groups. You can collapse or expand individual groups by clicking the arrow next to the 

group name. 

Show Status Messages 

Toggles the display of users' custom status messages under their names in the Wimba Pronto window. If this option 

is disabled, you can view a user's status by hovering your mouse over his or her name. 

  

See Also: 

Blocking and Unblocking Users 
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Blocking and Unblocking Users 

By default, all Wimba Pronto users can freely communicate with each other, regardless of whether or not they are in 

same classes, or even at the same institution. However, if there are users that you do not want to be able to contact 

you, you can block them. Blocked users cannot contact you, and you cannot contact them. If the user is in either 

your Contacts or Classmates tab, you can still see his or her status, but you always appear as offline to the blocked 

user. Users never know that they have been blocked, and you can unblock users at any time.  

  

You can block or unblock a user from either the Wimba Pronto window or the Preferences window. Also, if 

someone not in your Contacts or Classmates tab contacts you, you are given the option of blocking the user. 

To Block a User from the Wimba Pronto Window 

1. Right-click (Ctrl-click on Mac) the name of the user that you wish to block in either the Classmates or 

Contacts tab. 

2. Select Block <User Name> from the pop-up menu. The Block Contact window opens. 

3. Click Yes. The name appears with a strikethrough to indicate that the user has been blocked. 

 

Note: 

If the user is already blocked, the Block <User Name> option changes to Unblock <User Name>; you can use 

this option to unblock the selected user. 

Tip: 

If you do not want blocked users to appear in your Contacts and Classmates tabs, disable Show Blocked 

Contacts in the View menu. 
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To Manage Blocked Users from The Preferences Menu 

1. Click the Pronto menu (Windows) or the File menu (Mac). 

2. Select Preferences... The Preferences window opens. 

3. Select Privacy. 

4. Add or remove users from your Block List as desired: 

• To add a user to your Block List, click the plus button , type the user's Pronto ID, and click Add. 

• To remove a user from you Block List, select the user from the list and click the minus button . 

 

5. When you have finished modifying the Block List, click OK. 

  

Tip: 

Since the Block List allows you to block users by their Pronto IDs, you can use this method to block any Wimba 

Pronto user— even if he or she is not in any of your classes. 

 

See Also: 

Privacy Preferences 

Changing Your Display Settings 
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Viewing a User's Profile 

Any Wimba Pronto user can create a Profile to share with friends, classmates, and instructors. You can use Profiles 

to find out more information about a user, or to find a user's contact information (if he or she has shared it).  

  

You can see a partial profile by hovering your cursor over a user's name in your Contacts or Classmates tab. This 

view shows you the user's picture, current status, and About Me description; it does not show email addresses or 

webpages. 

To View a User's Profile 

1. Click the name of the desired user in either your Contacts or Classmates tab. 

2. Click the Actions menu. 

3. Select Show Profile Info. A new Text Chat window opens with the user's profile displayed. 

  

 
Note: The Video Call and AppShare buttons are advanced features in Wimba Pronto and are not available in Wimba 

Pronto Basic. 

  

See Also: 

Modifying Your Profile 
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Accessing the Wimba Pronto Settings Page 

The Wimba Pronto Settings page is a web portal that allows you to view and manage your account settings and 

login information, as well as determine which of your courses appear in Wimba Pronto Basic. You can access the 

Wimba Pronto Settings page either from a link within Wimba Pronto Basic, or directly using your web browser. 

To Access the Wimba Pronto Settings Page from Wimba Pronto Basic 

1. Click the Pronto menu (Windows) or the File menu (Mac). 

2. Select Account Settings. The Wimba Pronto Settings login page opens in your web browser. 

 

 
 

3. Type your Pronto ID. 

4. Type your Pronto Password. 

5. Click the Sign In button. 

To Access the Wimba Pronto Settings Page from a Web Browser 

1. Go to the URL: http://pronto.wimba.com/ 

2. Type your Pronto ID. 

3. Type your Pronto password. 

4. Click the Sign In button. 

  

Tip: 

You can also access the Wimba Pronto Settings page, without logging in again, from your CMS. If you forget your 

password and security question, this is the best way to access your Wimba Pronto account.  

  

See Also: 

Modifying Your Account Settings 

Modifying Your Course Settings 
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Modifying Your Account Settings 

From the Wimba Pronto Settings page, you can view and modify your account settings including your password, 

the email address associated with your account, and your security question. 

  

 

To Change Your Password 

1. On the Wimba Pronto Settings page, click the change password... link. The Change Password window 

opens. 

2. Type your current password in the Current password field. 

3. Type your desired password in the New password field. 

4. Re-type your desire password in the Confirm new password field. 

5. Click the Save button. The Password changed confirmation page opens, indicating that your new password 

has been successfully updated.  

To Change the Email Address Associated with Your Wimba Pronto Account 

1. On the Wimba Pronto Settings page, click the change email... link. The Change Email window opens. 

2. Type your Pronto password in the Current password field. 

3. Type the email address that you would like associated with your Wimba Pronto account in the New Email 

field. 

4. Re-type the desired email address in the Confirm New Email field. 

5. Click the Save button. The Email changed confirmation page opens, indicating that your new email address 

has been set successfully. 

  

Note: 

The email address associated with your Wimba Pronto account does not have to be a school email address or the 

email address associated with your CMS account. 

To Change Your Security Question 

1. On the Wimba Pronto Settings page, click the change security question... link. The Change Security 

Question window opens. 

2. Select a Security Question from the drop-down menu. 

3. Type your response in the Answer field. 

4. Click the Save button. The Security Question changed page opens, indicating that your security question 

has been successfully updated.  
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To Change the Language Setting for Your Wimba Pronto Account 

1. On the Wimba Pronto Settings Page, click the Language drop-down menu. 

2. Select the desired language. 

To Delete Your Wimba Pronto Account  

1. On the Wimba Pronto Settings page, click the Support link. The Wimba Pronto Support page opens. 

2. Click the Delete Your Account link. The Delete Your Account page opens. 

3. Select a reason for deleting your Pronto Account from the drop-down menu. 

4. Add any additional comments in the Comments box. 

5. Click the Continue button. The Confirm Delete page opens. 

6. Type your Pronto password in the Password field. 

7. Click the Delete this account button. Your account is deleted. 

  

Note: 

Reasons for deleting your Wimba Pronto account include if you are unhappy with your Pronto ID or if you 

accidentally created more than one account. 

  

See Also: 

Accessing the Wimba Pronto Settings Page 

Modifying Your Course Settings 

Language Settings 
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Modifying Your Course Settings 

The Wimba Pronto Settings page allows you to individually enable or disable Wimba Pronto Basic for each of your 

courses. This can be accomplished in the Course Settings area of the page. 

  

 

General  

Checking the box under the General heading allows you to select whether Wimba Pronto Basic is automatically 

enabled for new courses in which you enroll. Keep in mind that this setting will remain in effect for future 

semesters. 

Course Participant 

The Course Participant section contains a list of all of the courses for which you can enable Wimba Pronto Basic. 

Check the box next to a course name to enable Wimba Pronto Basic or uncheck the box to disable it.  

Course Instructor 

This section is visible only if you are the instructor of a course. You have the option of enabling or disabling Wimba 

Pronto Basic for an entire course.  

  

Note: 

All of the course settings above only affect whether or not a course is visible in your Classmates tab. Enabling or 

disabling Wimba Pronto Basic for a course does not affect whether or not users enrolled in the course have access 

to Wimba Pronto Basic via other courses, or whether or not they can communicate with their contacts.  

See Also: 

Accessing the Wimba Pronto Settings Page 

Modifying Your Account Settings 
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Text Chat 

About Text Chat 

Text Chat is the simplest form of communication in Wimba Pronto Basic and, in many cases, it is also the most 

effective. Also known as instant messaging, Text Chat allows you to send a message, which is received immediately, 

to any user currently logged in to Wimba Pronto Basic. The user can then reply to your message and you can have a 

conversation via a series of instant messages.  

  

Text Chat can also be used as a starting point for accessing Wimba Pronto Basic's more advanced features. For 

example, before starting an Audio Call with someone, you may wish to send the user an instant message to make 

sure that they have a microphone connected. 
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The Text Chat Window 

The Text Chat window is where instant messaging conversations take place. When you start a new Text Chat, this 

window opens, showing you all of the messages that have been sent and allowing you to type new messages. 

  

 
Note: The Video Call and AppShare buttons are advanced features in Wimba Pronto and are not available in Wimba 

Pronto Basic. 

The Audio Call Button 

The Audio Call button allows you to start an Audio Call with the person with whom you are currently instant 

messaging. When you click the Audio Call button, the other user receives a notification of an incoming call, and can 

then accept or reject the call. It is possible to simultaneously use Audio Calling and Text Chat with the same user; if 

you start an Audio Call from the Text Chat window, your existing Text Chat remains open. 

The Profile Drawer Button 

Clicking the Profile button reveals a drawer showing the user's profile information and current status. Clicking the 

button again hides the drawer. 

The Message Area 

The Message area displays all of the messages that have been sent between you and the other user. The user's 

name appears every time the sender of the message changes; the time that each message was sent is displayed 

along the right side of the window. You can use the scrollbars to see older messages not currently visible in the 

window.  

The Text Input Area 

The Text Input Area is where you type new messages. Messages are not visible to the other user until you press the 

Enter key on your keyboard to send them. Sent messages then appear in the Message Area. You can use the drop-

down menu on the right side of the area to add emoticons to your message. 
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Chat Tabs 

Below the Text Input Area are the Chat tabs. These tabs show the name and status of the users with whom you are 

currently messaging. They also display the pencil icon  when the other user is typing. This indication can be 

useful for helping you to avoid typing at the same time as another user. If you have multiple text chats open, each 

session is represented by a separate tab; clicking a tab brings the conversation into focus. Tabbed chat is enabled 

by default, but can be disabled in the Preferences window.  

  

See Also: 

Starting a New Text Chat 

About Audio Calling 

Emoticons 
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Starting a New Text Chat 

Before you can start a new Text Chat with someone, the user must first be in either your Contacts or Classmates tab. 

There are several ways to start a new Text Chat with a contact or classmate.  

To Start a New Text Chat 

1. Do one of the following: 

• Double-click the name of the user you wish to contact in either the Contacts or Classmates tab. 

• Click the name of the user you wish to contact and press the Enter key on your keyboard. 

• Click the name of the user you wish to contact and select Send Instant Message from the Actions 

menu. 

 

A new Text Chat window opens. 

 

 
Note: The Video Call and AppShare buttons are advanced features in Wimba Pronto and are not available in Wimba 

Pronto Basic. 

 

2. Type your first message in the Text Input Area. 

3. Press the Enter key on your keyboard. The Text Chat session starts and your message is sent. 

  

See Also: 

The Text Chat Window 
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Emoticons 

Emoticons are special graphical icons that you can insert into any text-based chat to make your conversations more 

expressive and fun. The emoticons drop-down menu is located on the right side of the Text Input Area in all Text 

Chat windows.  

  

 
  

To insert an emoticon into your message, you can either click the image in the drop-down menu, or type its key 

combination (which is displayed in the lower left-hand corner of the drop down).  

  

Note: 

You can disable emoticon display in the Preferences window. 
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Audio Calling 

About Audio Calling 

Audio Calling can be used to make online communication more fluid and natural. Also known as Voice over IP 

(VoIP), Audio Calling allows you to have a real-time audio conversation with any user currently logged in to Wimba 

Pronto Basic. Audio Calling differs from Text Chat in that you must call a user and wait for him or her to accept your 

invitation before your call can begin. You can also use Audio Calling in combination with other Wimba Pronto Basic 

features such as Text Chat, and Group Chat. You can use Audio Calling with your computer's built-in microphone 

and standard headphones; but for best call quality, it is recommended that you have a USB headset with an 

integrated microphone. 
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The Audio Call Window 

The Audio Call window opens when you accept a new incoming call, or when a call you start is accepted by another 

user. The window contains all of the controls and settings for managing your Audio Calling session. 

  

 

The User Display Area 

The User Display Area shows the first name and profile picture of the user with whom you are speaking.  

The Call Status Bar 

The Call Status bar shows your network signal strength, the level of your outgoing audio signal, and the level of the 

incoming audio signal. 

The Talk/Lock Talk Button 

The Talk/Lock Talk button allows you to control your outgoing audio. To talk, either click and hold the Talk button, 

or press and hold either F8 or the Space Bar on your keyboard. If you would like to speak hands-free, either click 

the padlock section of the button, or press Ctrl+T (Windows) or Command+T (Mac) on your keyboard. 

  

Note: 

Unlike talking on a telephone, on an Audio Call the other user cannot automatically hear you speak. You must use 

the Talk/Lock Talk button or keyboard shortcuts to enable your outgoing audio. 
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The Options Menu 

The Options menu contains Audio Calling settings, as well as shortcuts for launching other Wimba Pronto Basic 

features directly from your current call. 

 

• Lock Talk has the same effect as clicking the padlock section of the Talk/Lock Talk button; select this option 

to lock on your outgoing audio.  

• Hide Call Status allows you to toggle the display of the Call Status bar in the Audio Call window. 

• Preferences... opens the Preferences window to the Calls area, allowing you to manage your audio devices 

and system audio settings. 

• Chat opens a new Text Chat window between you and the user with whom you are currently speaking. 

• End Call ends the current Audio Call.  

  

See Also: 

Starting a New Audio Call 
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Starting a New Audio Call 

Before you can start a new Audio Call with someone, the user must first be in either your Contacts tab or your 

Classmates tab. Once someone is either a contact or a classmate, you can start an Audio Call through the Text Chat 

window.  

To Start a New Audio Call 

1. Do one of the following: 

• Double-click the name of the user you wish to call in either the Contacts or Classmates tab. 

• Select the name of the user you wish to contact and press the Enter key on your keyboard. 

 

The Text Chat window opens. 

 

Note: The Video Call and AppShare buttons are advanced features in Wimba Pronto and are not available in Wimba 

Pronto Basic. 

2. Click the Audio Call button. A new Audio Call window opens, displaying the status Calling.  

  

When the user accepts the call, the Calling status is replaced by the Call Status bar, Options menu, and the 

Talk/Lock Talk button.  

  

See Also: 

The Audio Call Window 

The Text Chat Window 
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Group Chat 

About Group Chat 

Similar to an online chat room, Group Chat allows you to communicate with multiple users simultaneously. Group 

Chat starts in text-only mode, but you can access any of Wimba Pronto Basic's other features — such as Audio 

Calling — from a Group Chat session. For example, if you are in a text-only Group Chat session, you can add Audio 

Calling to create group Audio Call, similar to a telephone conference call. You can invite new participants to a 

Group Chat either while creating it, or after the session has already been created. Any participant, including the 

creator of the Group Chat, can leave a session at any time and the other participants are still able to continue the 

session. 
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The Group Chat Window 

The Group Chat window is similar to the Text Chat window, but with one major difference: the Group Chat window 

has a Participant List to the right of the Message Area that displays the names and the statuses of all of the users 

currently in (or invited to) the Group Chat session.   

  

  

 
Note: The Video Call and AppShare buttons are advanced features in Wimba Pronto and are not available in Wimba 

Pronto Basic. 

The Audio Call Button 

The Audio Call button allows you to start an Audio Call with the participants of the current Group Chat. When you 

click the Audio Call button, all of the current Group Chat participants receive a notification of an incoming call, 

which they can then individually accept or reject. It is possible to simultaneously use Audio Calling and Text Chat; if 

you start an Audio Call from a Group Chat session, your existing Group Chat window remains open. All participants 

do not have to accept the Audio Call invitation for it to function, but only those who do are able to hear the audio 

of the call.  

The Profile Drawer Button 

The Profile button shows the profile picture of the last user to type a message or speak (if you are using Audio 

Calling). Selecting a user from the Participant List shows the user's profile picture for 15 seconds. Clicking the Profile 

button reveals a drawer showing the user's profile information and current status. Clicking the button again hides 

the drawer. 
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The Message Area 

The Message Area displays all of the messages that have been sent between the participants of the Group Chat. The 

user's name appears every time the sender of the message changes; the time that each message was sent is 

displayed to the right of the message. You can use the scrollbars to see older messages (sent since you entered the 

Group Chat) not currently visible in the window.  

The Participant List 

The Participant List displays the names, Pronto IDs, and current statuses of all of the users in the Group Chat 

session. You can right-click (Ctrl-click on Mac) the name of a participant to access the user's profile, webpages, and 

email link. The pencil icon  is displayed next to the names of users that are currently typing a message. This 

indication can be useful for helping you to avoid typing at the same time as another user. The pending icon  

next to a user's name indicates that the user has received an invitation to join the session, but has not yet accepted 

it. An invitation can be canceled at any time before a user accepts it by hovering over the pending icon and clicking 

the x that appears. Only the person that invited a user can cancel his or her invitation. 

The Text Input Area 

The Text Input Area is where you can type new messages. Messages are not visible to other users until you press 

the Enter key on your keyboard to send them. Sent messages then appear in the Message area. You can also use 

the drop-down menu on the right side of the area to add emoticons to your message. 

  

See Also: 

Starting a New Group Chat 

Inviting New Users to a Current Group Chat 

About Audio Calling 

Emoticons 
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Starting a New Group Chat 

Before you can start a new Group Chat, the users that you wish to invite to the session must first be in either your 

Contacts or Classmates tab. Once the desired users are either contacts or classmates, there are several ways to start 

a new Group Chat. 

To Start a New Group Chat 

1. Select at least one of the users that you wish to invite in either the Contacts or Classmates tab. 

• You can select multiple users to invite them all at the same time (you can always invite additional 

participants later). 

• To select multiple users, Ctrl-click (Windows) or Command-click (Mac) their names. 

2. Do one of the following: 

• Right-click (Ctrl-click on Mac) the name of one of the selected users and select Invite to Group Chat > 

New Group Chat... 

• Press Ctrl+G (Windows) or Command+G (Mac) on your keyboard. 

 

The Invite to Group Chat window opens. 

 

 
 

3. Type a name for the session in the Group Chat field. 

4. If you wish to invite additional participants, type their names in the Invite field. The names that you type are 

automatically completed based on the names in your Contacts and Classmates tabs. Press Enter on your 

keyboard to add the user to the Invited list. 

5. If you wish to remove a user from the Invited list, click the x icon  next to the user's name. 
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6. Click Invite. The new session is created, a Group Chat window opens, and invitations are sent to all of the 

users in the Invited list.  

  

Tips: 

a) You can return to a Group Chat by selecting Recent Group Chats > from the Pronto menu (Windows) or the 

File menu (Mac). This can be especially useful if you leave a Group Chat unintentionally.  

b) You can start a new Group Chat based on a previously created session by selecting the name of the session 

(instead of New Group Chat) from the Invite to Group Chat > menu, or from the drop-down menu in the Invite 

to Group Chat window. This preserves only the name of the session and does not allow you to see previously 

sent messages. It also does not automatically invite the users from prior sessions. 

  

See Also: 

The Group Chat Window 

Inviting New Users to a Current Group Chat 
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Inviting New Users to a Current Group Chat 

At any time during a Group Chat, you can invite new users to join the session. You can invite a single user at a time 

or multiple users. Any current participant can invite new users, not just the creator of the session.  

 

To invite a new user, drag and drop the name of the user anywhere in the Group Chat window. The user's name 

appears with the pending icon  in the Participant List. This indicates that the user has received an invitation to 

join the session, but has not yet accepted it. 

  

Tip: 

An invitation can be canceled at any time before a user accepts it by hovering your cursor over the pending icon 

and clicking the x icon  that appears . Only the person that invited a user can cancel his or her invitation. 

  

See Also: 

The Group Chat Window 

Starting a New Group Chat 
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Preferences 

Accessing the Preferences Window 

The Preferences window gives you access to wide range of options and settings for using Wimba Pronto Basic.  

To Access the Preferences Window 

1. Click the Pronto menu (Windows) or the File menu (Mac). 

2. Select Preferences... The Preferences window opens. 

  

 
  

The Preferences window is separated into different sections: General, Appearance, Status, Alerts, Calls, Privacy, and 

Profile. 
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General Preferences 

 

Sign In 

• Start Pronto when my computer starts automatically launches Wimba Pronto Basic every time you turn 

on your computer.  

• Sign me in when Pronto starts automatically signs you on to Wimba Pronto Basic using the current 

Wimba Pronto account every time you launch the program. 
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Messages 

• Use tabbed chats opens new text chats as tabs within one window, rather than separate windows. 

• New message window is always blank opens new Text Chat windows without showing previous 

messages sent between you and the other user. 

• Enter key sends messages (Shift-Enter for line break) allows you to use the Enter key on your keyboard 

to send messages in Text Chat. 

• Warn me before closing a chat with multiple participants displays a warning dialog when you try to 

close a chat window with more than one participant. 

• Give keyboard focus to new messages brings incoming messages to the front or, if tabs are enabled, 

automatically displays the tab of the new messages. 

• Disable emoticons disables the display of emoticon images. 

Updates 

• Automatically check for Pronto updates allows you to set whether Wimba Pronto Basic automatically 

checks for new software updates. If selected, the When Pronto updates are found: options can be 

modified. 

o Ask me what I want to do prompts you before downloading an update. 

o Automatically download the update downloads updates without notifying you. 

Chat Logs 

• Save chat logs allows you to set whether or not chat logs of all of your Text Chat conversations are 

automatically saved on your hard drive. 

Language 

The Language drop-down menu allows you to set the language for the Wimba Pronto Basic interface. By default 

this is set to match the language setting for your computer's operating system (if possible). 
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Appearance Preferences 

 

Messages  

The Messages area displays of preview of the current appearance settings for the Text Chat window; any changes 

you make in the sections below are reflected in this preview. 

Header 

You can change the text color for your name and the names of other users in the text chat window by clicking the 

respective color boxes. You can change the font for the names by clicking the Choose Font... button. 
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Message Body 

You can change the color of the message text in the text chat window by clicking the color box labeled text. You 

can change the background color of the text chat window by clicking the color box labeled bg. You can change the 

font for the message text by clicking the Choose Font... button.  

Contact List 

You can change the font that is used to display the names of users, groups, and courses by clicking the Choose 

Font... button in the Contact List area. 

Reset Appearance Defaults 

If you want to undo all changes you have made and return to the original appearance defaults, click the Reset 

Appearance Defaults button. 
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Status Preferences 

The Status section allows you to add, delete, and modify your custom status messages. Statuses that you have 

already created are shown in the list.  

  

 
  

You can add a new status by clicking the plus button  or remove a selected status by clicking the minus button 

. Select a status and click Edit to modify it. The Auto-Idle check box allows you to set a time after which your 

status is automatically set to idle.  
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Alerts Preferences 

The Alerts section allows you to set a custom alert profile for a number of different actions in Wimba Pronto Basic.  

  

 
  

• When this happens: lists all of the actions for which you can set alerts.  

• Once you select an action from the list, you can set which type of alert you want to associate with it in the 

Do this: area.  

• The Use alerts for my contacts only checkbox is a global setting that allows you to apply the alerts that 

you have defined only to people in your Contacts tab.  

• Alert sound output: allows you to choose the sound device used for playing alert sounds. 
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Calls Preferences 

 
Note: Video Calling and Video Settings are advanced features in Wimba Pronto and are not available in Wimba Pronto 

Basic. 

  

• Audio Input allows you to select the device that Wimba Pronto Basic uses for incoming audio. 

• Audio Output allows you to select the device that Wimba Pronto Basic uses for outgoing audio. 

• Auto Gain Control can help normalize the volume of incoming and outgoing audio by automatically 

boosting low-level audio and lowering high-level audio.  

• Microphone Boost raises the level of your audio input if your microphone level is too weak.   

• Noise Reduction can help reduce the level of background noise picked up by your microphone.  

• Silence Detection allows you to transmit audio only when you are speaking, preventing static or 

background noise.  

• Automatically select new devices when inserted allows you to set whether or not Wimba Pronto Basic 

automatically uses audio devices that are connected while the program is running. 
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Privacy Preferences 

 
  

• Block List displays users that you have blocked from contacting you. 

• The plus button  allows you to add new users to your Block List. 

• The minus button  allows you to remove selected users from your Block List. 

• Sign in as invisible automatically sets your status to invisible when you log in to your Wimba Pronto 

account. 

• Don't show when I am typing disables the pencil icon  that informs other users that you are typing. 

• Make me invisible to anyone not in my classes or contacts always displays your status as invisible to any 

user not in your Contacts or Classmates tab.  
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Profile Preferences 

 

Profile Picture  

You can add a picture that is visible to other Wimba Pronto users to add a personal touch to your profile. Your 

picture is visible any time you contact another Wimba Pronto user, anytime another user contacts you, when a user 

views your profile, or when a user hovers his or her cursor over your name in the Contacts or Classmates tab. To add 

a profile picture, either drag and drop an image file from your hard drive to the Drag Image Here box, or click the 

Choose Picture... button and browse your hard drive for the desired picture. The profile picture box is optimized 

for square images, but accepts images of any proportions.  
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Email 

You can add an email address to make it easier for other users to contact you even if you are not online. This 

address does not need to be your school email address, or the address associated with your Wimba Pronto account. 

About Me 

The About Me box allows you to enter a brief description to introduce yourself to other users. This could include 

your interests, your major, where you're from, or the type of people with whom you would like to communicate 

using Wimba Pronto Basic.  

My Webpages 

The My Webpages box allows you to include links in your profile to the webpages of your choice. 
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Message Logs 

Saving a Single Chat 

While it is possible to enable Wimba Pronto Basic to automatically save message logs of all of your Text Chats, you 

can also save a single chat as an .html file. This feature can be useful if there is information in a chat session that you 

want to be able to refer to later, but you don't want to have to search through all of your message logs to find it. 

You can save a single chat from both Text Chats and Group Chats. 

To Save a Single Chat 

1. Click the File menu in the window of the chat that you wish to save. 

2. Select Save As... The Save Chat Log window opens. 

3. Choose the location where you wish to save the log. 

4. Type a name for the log in the File name box. 

5. Click Save. 

  

See Also: 

Viewing Message Logs 

Enabling Automatic Message Log Saving 
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Enabling Automatic Message Log Saving 

By default, automatic message log saving is disabled in Wimba Pronto Basic. If you wish to automatically store 

messages logs of all of your Text Chats, you can enable this feature in the Preferences window.  

To Enable Automatic Message Log Saving 

1. Click the Pronto menu (Windows) or the File menu (Mac). 

2. Select Preferences... The Preferences window opens. 

3. Select General (if it is not already selected).  

 

 
 

4. Check the Save chat logs box. 

5. Click OK. 

  

Note: 

If you upgraded to Wimba Pronto Basic 2.1 from an earlier version, message log saving may already be enabled 

by default. Uncheck the Save chat logs box to disable it. 

See Also: 

Viewing Message Logs 

Saving a Single Chat 
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Viewing Message Logs 

You can set Wimba Pronto Basic to automatically store messages logs of all of your text chats. If enabled, logs are 

saved to your hard drive as plain text files that contain the text, time, and date sent for each message. Messages 

logs are never stored on the Wimba Pronto Basic server. There are two ways to access message logs: you can either 

browse through all of the available logs, or you can view the message log between you and a particular user. 

To View the Message Log Between You and a Particular User 

1. Click the name of the desired user in either the Contacts or the Classmates tab. 

2. Click the Actions menu. 

3. Select Show Message Log. The message log opens. 

To View Browse All Message Logs 

1. Click the Actions menu. 

2. Select Browse Message Logs. The directory containing all of your message logs opens. 

  

See Also: 

Enabling Automatic Message Log Saving 

Saving a Single Chat 
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Language Settings 

Wimba Pronto Basic is available in both English and Spanish. The client contains both languages; there is no need 

to download additional language packs. You can change your personal language preference at any time. If you do 

not set a language preference, Wimba Pronto Basic uses the language preference from your computer's operating 

system (if possible). If your computer's operating system is set to a language other than English or Spanish, Wimba 

Pronto Basic defaults to English.  

  

The Wimba Pronto Settings page is also available in English and Spanish. The default language for the page is set 

by your institution's Wimba Pronto Administrator and can be modified individually by each user.  

To Change the Language Setting for the Wimba Pronto Basic Client 

1. Click the Pronto menu (Windows) or the File menu (Mac). 

2. Select Preferences... The Preferences window opens. 

3. Select General (if it is not already selected). 

4. Select the desired language from the Language drop-down menu. 

 

 
 

5. Click OK. Your language preference for the Wimba Pronto Basic client is set.  

  

Note: 

The language setting that you select in the Preferences window is maintained even if you log out and log back in 

to the Wimba Pronto Basic client. 

To Change the Language Setting for the Wimba Pronto Settings Page 

1. Access the Wimba Pronto Settings page. 

2. Click the Language drop-down menu. 

3. Select the desired language. Your language setting for the Wimba Pronto Settings page is set. 

  

Note: 

Changing the language setting for the Wimba Pronto Settings page does not affect the language display setting 

for the Wimba Pronto Basic client. 

  

See Also: 

General Preferences 

Accessing the Wimba Pronto Settings Page 

Modifying Your Account Settings 
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Keyboard Shortcuts 

The following keyboard shortcuts can make it easier to access certain features in Wimba Pronto Basic: 

  

General Keyboard Shortcuts 

  

• Start a New Group Chat : Ctrl+G (Windows), Command+G (Mac) 

• Access the Preferences window: Ctrl+, (Windows), Command+, (Mac) 

• Add a Group to the Contacts tab: Ctrl+Shift+G (Windows), Command+Shift+G (Mac) 

• Add a Selected Classmate to the Contacts tab: Ctrl+Shift+A (Windows), Command+Shift+A (Mac) 

• Start an Audio Call with the Selected User: Ctrl+K (Windows), Command+K (Mac) 

  

During an Audio Call 

  

• Talk: F8 or Space Bar (F8 works when any part of the Wimba Pronto Basic application has focus; 

Space Bar works only when the Audio Call window has focus) 

• Toggle Lock Talk: Ctrl+T (Windows), Command+T (Mac) (Works when any part of the Wimba Pronto Basic 

application has focus.) 

• End Call: Ctrl+F4 (Windows), Command+F4 (Mac) 
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Software Updates 

From time to time, Wimba releases new software updates for Wimba Pronto Basic. By default, the program 

automatically checks for updates periodically and, when an update is found, asks you whether or not you want to 

download it. You can change these settings in the Preferences window. You can also manually check for updates at 

any time. 

To Change Your Software Update Settings 

1. Click the Pronto menu (Windows) or the File menu (Mac). 

2. Select Preferences... The Preferences window opens. 

3. Select General (if it is not already selected). 

 

 
 

4. In the Updates area, adjust the settings as desired: 

• Automatically check for Pronto updates allows you to enable or disable automatic update detection. 

If selected, the When Pronto updates are found: options can be modified: 

o Ask me what I want to do asks you whether or not you want to download updates when they 

are detected. 

o Automatically download the update downloads updates when they are detected without 

asking you first. 

5. Click OK. 

To Manually Check for Software Updates 

1. Click the Help menu in the Wimba Pronto window. 

2. Select Check For Updates... A dialog box appears, telling you whether or not new updates are available. 
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Additional Resources 

To access all of Wimba's support resources, visit:   

http://www.wimba.com/support 

Technical Support 

If you experience technical difficulties while using Wimba Pronto Basic, please contact Wimba at:  

technicalsupport@wimba.com 

Additional Documentation 

For information on installing Wimba Pronto Basic in a computer lab setting, see the Wimba Pronto 2.1 Computer Lab 

Installation Guide 

Community 

We encourage Wimba users of all levels to join our Wimba Connect User Group, a new community in which users 

can share their experiences, ideas, research, and best practices with their peers via forums and user-generated 

blogs. In addition to bringing our users closer together, the group acts as a 365-day-a-year extension of our annual 

Wimba Connect Global Users Conferences.  

  

For more information, or to register for the Wimba Connect User Group, visit http://www.wimba.com/community. 
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Product Feedback 

Wimba welcomes your comments and suggestions. If you have an idea for a new feature or enhancement, or would 

like to send other feedback, please click the link below:  

Wimba Product Feedback Form 

  

You may also email your suggestions to feedback@wimba.com  

  

Your suggestion will be sent directly to Wimba's Product Management Team. 
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Disclaimer 
This Guide, as well as the software described in it, furnished under license may only be used or copied in 

accordance with the terms of such license. The information in this Guide is furnished for information purposes only, 

is subject to change without notice, and should not be construed as a commitment by Wimba, Inc. Wimba, Inc. 

assumes no responsibility or liability for any errors or inaccuracies that may appear in this Guide. Except as 

permitted by such license, no part of this Guide publication may be reproduced, stored in a retrieval system or 

transmitted in any form by any means, electronic, mechanical, recording or otherwise without the prior written 

permission of Wimba, Inc. Any references to company names in examples or illustrations are for demonstration 

purposes only and are not intended to refer to any actual organizations.  

  

Wimba Pronto Basic and the Wimba logos and trademarks are property of Wimba, Inc., 10 East 40th St, Floor 11, 

New York, NY, 10016.  
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